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 Software Introduction 

Unico control platform is a device operation and control software with innovative interactive 

design. It supports a wide variety of device integrations, providing users with a unified control 

platform. This delivers an easy-to-use, intuitive, professional, efficient, and creatively limitless 

control experience. 

 Unified operation and control 

Unico supports a wide range of devices for unified management, including LED display 

controllers, presentation switchers and all-in-one controllers. It meets the daily operation 

needs across various applications. With Unico, there's no need to install multiple software or 

learn different interfaces. You can handle all video processing and sending configurations 

with just one platform, significantly reducing the learning curve. 

 Simplified man-machine interaction 

Oversee the entire workflow of on-site operations using screen-based management. Easily 

view detailed information on device status, input and output configurations, screen 

configuration, color adjustments, layers, presets, and MVRs. This approach transforms 

complex information into a clear, easily digestible format at a glance. 

 Interactive screen configuration 

The visualized screen configuration allows you to effortlessly control LED screen and video 

screen configurations. It supports screen configuration without the need for devices or 

cabinets, making it easier to create offline configuration files. Furthermore, the connector 

rotation feature opens up more possibilities for creative displays. 

 Image mosaic 

Cascading multiple devices allows for the display of larger images. Furthermore, using 

irregular mosaics enables more flexible and diverse visual effects tailored to specific design 

needs. 

 End-to-end backup 

Supports backup between devices, Ethernet ports, OPT ports/Ethernet ports, input sources 

and project files, enhancing reliability of each link and avoiding business interruption caused 

by link failures. 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 6 
 

 Software Installation and Connection 

Software Installation 

Prerequisites 

 The software package is obtained. 

 A computer meeting the following requirements is prepared: 

Windows: 

− Operating system: Windows 10 (64-bit) or later 

− CPU: 9th Generation Intel i7 processor or above 

− Memory: 16 GB or above 

Mac OS: Mac OS 10.14 or above 

Installation Method 

Run the .exe file and follow the setup wizard to complete the installation. If a firewall prompt 

appears, choose to allow the installation. 

Installation Result 

After a successful installation, the Unico software icon  is displayed on the desktop. Double-

click this icon to open the Unico software. 

Software Connection 

The Unico software is installed on the control computer. The control computer can connect to 

the device in the following two ways: 

 Via Ethernet cable 

Connect the device and the control PC directly via Ethernet cable and set a static IP address 

for the device to let it and the control PC be on the same network segment. 

 Via LAN 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 7 
 

Connect the device and the control PC to the same LAN to ensure that both of them are on 

the same network segment. 
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 All-in-One Controllers 

Project Management 

Create, edit and dissolve projects. Project files (.uprj) can be exported from the current device 

and imported into others, promptly applying device parameters and resource files. 

Create New Projects 

Devices of the same series on a local network are automatically added to a default project. 

Users can create additional projects and move online devices from the default project to new 

ones. Furthermore, simulation projects can be created to simulate real device configurations 

and understand the product better. 

Step 1 Open the software and access the main interface. 

Figure 3-1 Project 

 

Step 2 Create an online project or simulation project. 

 Online Project: Create a project for online devices. Select the Online Project tab at the top 

left and click New Project at the top right. Enter the project name in the popup window and 

click OK. 
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Figure 3-2 New projects 

 

 Simulation Project: Create a project for simulation devices. Select the Simulation Project tab 

at the top left and click New Project at the top right. Enter the project name in the popup 

window and click OK. 

After a simulation project is successfully created, please refer to Simulation Devices to add a 

simulation device. 

For online projects, devices of the same series are automatically grouped under one project. 

When adding simulation devices, only devices of the same series can be included in a single 

project. 

 

In the project list area, you can perform the project-related operations. 

 Edit project: Click Edit to rename the project. 

 Export project: Click Export to export the online project file. Simulation projects do not support 

exporting. 

 Dissolve project: Click Dissolve to dissolve the current project. All online devices in the project 

will be moved to the default project. 

 Enter project: Click Enter to enter the device configuration page. 
 

Step 3 Move devices between projects. 

Expand the project list, hover over the target device, and click Move or manually drag it to 

another project. 

 Move: Choose the target project in the popup window, then click OK. 
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Figure 3-3 Move devices 

 

 Manual drag: Manually drag to another project and click Yes in the popup window. 

 

Devices of the same series can only be added into one project. 
 

Import Projects 

Import the local project files (.uprj) to the device. Please note that the device models must 

match with the models in the project file. 

Step 1 Select the Online Projects or Simulation Projects tab, and click Enter to access the device 

configuration interface. 

Step 2 Navigate to File > Import from the menu bar. 

Step 3 In the dialog box that appears, select a project file (.uprj) and click OK. 

 

Simulation project files can be imported into online projects. 
 

Step 4 In the displayed Import Project File window, select Online Projects or Simulation Projects. 
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Figure 3-4 Import project files 

 

Step 5 After successful device matching, select the data to be imported and click OK. 

The software matches the SN, name, IP address, model, and firmware version from the file with 

the online or simulation device. Click  to modify the match: 

 For online devices, select other online devices from the drop-down menu. 

 For simulation devices, choose to create a new simulation device. Ignore the current device, 

or select another simulation device from the drop down menu. 

Export Projects 

Export the device project files to your local computer. 

Step 1 Select the Online Projects or Simulation Projects tab, and click Enter to access the device 

configuration interface. 

Step 2 In the menu bar, navigate to File > Export 

Step 3 In the displayed dialog box, select the desired data. 
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Figure 3-5 Export project files 

 

Step 4 Click Export. 

Step 5 In the displayed dialog box, select a file path and click Save. 

 

On the Online Projects interface, you can also click Export on the right side of the project list to 

export the project file. 
 

Device Management 

Enter Device Configuration Page 

Online Devices 

Step 1 Select the Online Projects tab. 
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Figure 3-6 Online project list (VX2000 Pro) 

 

Figure 3-7 Online project list (VC6 Pro) 

 

Step 2 Double click the device front panel image or click Enter on the right side of the project list to 

access the device configuration interface. 

Simulation Devices 

Simulation devices, without any physical connections, simulate real device configurations, 

enabling users to easily utilize and understand the software. 
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Step 1 Select the Simulation Projects tab. 

Step 2 Click Add simulation devices. 

 

The device models supporting the simulation device function include the VX400 Pro and VX2000 

Pro. 
 

Step 3 In the pop-up dialog box, set the device name, model, and IP address, and click OK. 

Once created, the device will be displayed in the list and will be in the default started state. 

 : The device is started. 

 : The device is off. 

Figure 3-8 New simulation devices (VX2000 Pro) 

 

 

For devices in the project list, you can perform the following operations: 

 Start all devices: Click Start All. 

 Shut down all devices: Click Shut Down All. 

 Shut down device: Click Shut Down. 

 Start device: Click Start. 

 Edit device: Click Edit. 

 Move device: For an active device, click Move, choose the target project in the popup window, 

and click OK. 
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 Delete device: Click Delete. 
 

Step 4 After creation, you can view the device status, name, IP address, and model. 

 Double click the device front panel image or click Enter on the right side of the project list to 

access the device configuration interface. 

 Hover over the device information to start, shut down, edit (modify device name, IP address), 

move, or delete the device. 

 

Configure Device Properties 

Select the device on the left side of the device configuration interface, and then configure the 

device-related properties on the right pane. 

Figure 3-9 Device properties (VX2000 Pro) 
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Figure 3-10 Device properties (VC6 Pro) 

 

 

Click Collapse to collapse the device list. 
 

Rename Device 

Change the device name. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

Enter a name for the device in the text box next to Device Name. 

Configure IP Address 

Manually set a static IP address for the device or let the device to automatically obtain an IP 

address. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

Devices on different network segments are not automatically discovered. If you change the 

device IP to another network segment, the device could not be discovered. 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 18 
 

Interface Example 

 

Description 

Configure the following parameters and click Apply to make the settings take effect. 

Parameter Description 

Network Mode Select the IP configuration method. 

 Manual: Manually set a static IP address for the device. 

 DHCP: The device automatically obtains an IP address. 

IP Address The device IP address 

Subnet Mask The subnet mask of the IP address 

Gateway The default gateway 

Configure Sync Source 

Select a sync signal to synchronize all the cascaded device units or synchronize the primary and 

backup devices to display the output images of all the units in sync. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 
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Note 

None 

Interface Example 

 

Description 

Parameter Description 

Sync To Select a sync source. 

 Internal Frame Rate: The frame rate of the output image 

 Input source connected to the device video connector: Sync with the frame rate 

of the selected input source. 

"X" represents the input source number and its format may vary depending on 

the actual setup. 

 Genlock: Sync with the frame rate of the Genlock signal. 

When the function is enabled, the frame rate of the sync source will be displayed. 

Frame Rate When you select Internal Frame Rate, you can manually set the output frame 

rate. The default value is 60Hz. 

Configure HDCP 

High-bandwidth Digital Content Protection (HDCP) is a form of digital copy protection to 

prevent copying of digital audio and video content as it travels across connections. When the 

accessed input source is an HDCP-encrypted one, you need to turn on this function to enable 

the device to transmit and process the source. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

None 

Notes 

None 

Interface Example 

 

Description 

Parameter Description 

HDCP Turn on or turn off the function. 

 : On 

 : Off 

Configure Date and Time 

Configure the time zone, date and time of the device. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

Click Edit and the parameters become editable. Set the time zone, date and time respectively, 

and then click Apply. 

Reset to Factory Settings 

Reset the device data and settings to factory default values. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

 Please do this with great caution. 

 The reset action does not affect the device firmware version. 

 Power-off is not allowed during the reset process. 

 The device will restart automatically after the reset is completed. 
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Interface Example 

 

Description 

Select Retain user data, Retain IP only or Reset all, and then click Apply. 

 Retain user data 

Retain the input EDID, imported files, language, device name, device IP, belonged project 

and restore points. 

 Retain IP only 

Only retain the device IP address and reset other parameters to factory defaults. 

 Reset all 

Reset all parameters. 

Standby Mode 

Enabling standby mode can effectively reduce energy consumption caused by screen heat 

generation. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 
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Notes 

Once the standby mode is enabled, the output image will go black and the output volume will 

be adjusted to 0. The device LCD screen will also be locked, while other parameters remain 

unchanged. 

Interface Example 

 

Description 

Parameter Description 

Standby Mode Turn on or turn off the function. 

 : On 

 : Off 

Restart Device 

Restart the device. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Interface Example 
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Description 

Click Restart, and then click Yes in the displayed dialog box. 

Configure Input Source Backup 

Establish a backup relation for two input sources. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

Input backup rules: 

 In each backup group, two input sources serve as the backup for each other. 

 The backup relation can only be established if the input connectors have identical capacities. 

 The USB source supports the input backup settings. 

 Each primary or backup source can have only one backup or primary source. 

 Restrictions on input backup functions: 

Input sources A and B form a hot backup group. The current input source of the layer is 

input source A. 

− Input A: No signal. Input B: Signal 

The layer input source is switched to input B automatically. When input A resumes and 

input B still has a signal and Primary Source Preferred is not enabled, the layer input 

source will not be changed. 

− Input A: No signal. Input B: Signal 

The layer input source is switched to input B automatically. When input A resumes, but 

input B does not have a signal, the layer input source will be changed to input A. 

− Input A: No signal. Input B: No signal 
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The layer input source will not be changed. 

− Input A: Signal. Input B: No signal 

If you manually switch the layer input source to input B, the source will automatically 

switch to input A. 

Interface Example 

 

Description 

Step 1 Select the Input Source Backup tab. 

Step 2 Toggle the switch next to Backup Status to . 

Step 3 Select or deselect Primary Source Preferred. 

 If Primary Source Preferred is enabled, the system will automatically switch to the primary 

source once it is restored. 

 If Primary Source Preferred is disabled, the system will not automatically switch when the 

primary source is restored and will continue using the backup source. 

Step 4 Click Add to add a backup relationship. 

Step 5 Select a primary source and a backup source respectively from two drop-down lists to establish 

a hot backup pair. 

The green dot  indicates the source is accessed normally and ready for use. 

 To delete a hot backup pair, click  next to the pair and click Delete. 

 To delete all hot backup pairs, click . 

Configure Input Properties 

Click the target input connector on the graphical device rear panel, and then set the input-

related properties in the property area on the right pane. 
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Figure 3-11 Input properties (VX2000 Pro) 

 

Figure 3-12 Input properties (VC6 Pro) 

 

View Input Source Info 

View the basic properties of the input connector and change the input connector name. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

A fine signal is connected to the input connector. 

Notes 

None 

Interface Example 

 

Description 

On the Basic tab interface, change the connector name as required. 

 

Hover the mouse over the target input connector, you can view the input source resolution, frame 

rate, bit depth and color/sampling rate. 
 

View OPT Source Info 

View the basic properties of the OPT source and change the OPT port name. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro, VX2000 Pro 
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Prerequisites 

 The device working mode is set to Video Controller. 

 OPT 1 and OPT 2 is connected to the OPT ports on the front-end video processor via optical 

fiber cables. Additionally, a fine signal is connected to the front-end device. 

Notes 

Each OPT support the transmission of 1x DL or 2x SL sources. 

Interface Example 

 

Description 

On the Input Source tab interface, change the connector name as required. 

Set Input Connector Capacity 

Switch the input connector capacity as desired. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 
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Interface Example 

When a connector is configured for hot backup, you can no longer switch its capacity. 

Interface Example 

 

Description 

Capacity Description 

SL  Standard resolution: 1920×1080@60Hz 

 Custom max width: 2048 (2048×1080@60Hz) 

 Custom max height: 2048 (1080×2048@60Hz) 

DL  Standard resolution: 3840×1080@60Hz/3840×2160@30Hz 

 Custom max width: 4096 (4096×1080@60Hz) 

 Custom max height: 3840 (1080×3840@60Hz) 

4K  Standard resolution: 4096×2160@60Hz/8192×2160@30Hz 

 Custom max width: 8192 (8192×1080@60Hz) 

 Custom max height: 8188 (1080×8188@60Hz) 

Configure Input HDCP 

Enable or disable the input HDCP encryption. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

For an HDCP source, it can only be properly recognized if the HDCP function on the input end is 

enabled; if the input HDCP is disabled, the HDCP source will by default display a black screen or 

snow. 

For a non-HDCP source, whether the HDCP function on the input end is enabled or not does 

not affect the normal transmission of the source image into the device. 

Configure InfoFrame Override Parameters 

Configure the InfoFrame override parameters of the input source, so that the device can use it 

when doing some calculations. This action does not change the parameter values that come 

with the input source. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example (VX2000 Pro) 

 

Interface Example (VC6 Pro) 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Color 

Space/Sample 

The sampling format of the input 

Bit Depth The bit depth of the input, i.e., the binary digits to represent a single color 

Quantization 

Range 

The quantization range of the input 

Gamut The color gamut standard 

Select From Input and the device will read the attribute values that come with the input source. 

Set HDR 

HDR is the abbreviation for High-Dynamic Range. HDR function can greatly enhance the display 

image quality, allowing for a more clear and vivid image when the device is used together with 

the specified receiving cards. 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 32 
 

Applicable Products 

VX2000 Pro 

Prerequisites 

 Use the layer 1 source as an HDR source. 

 An HDR source (HDR10/HLG standard) must be used to realize optimal HDR effect. 

Notes 

 An HDR source can be connected to the HDMI 2.0 or 12G-SDI connector only. 

 The HDR and 3D functions cannot be used together. 

 Using the HDR function paired with receiving cards of different models will reduce the 

device loading capacity by half or quarter because the HDR input source is 10-bit. Please 

work out a connection solution in advance. 

Interface Example 

 

Description 

Parameter Description 

Dynamic Range The dynamic range of an HDR source 

The supported options include HDR10, HLG, off 

and From Input. 

After the HDR source parameters are successfully set, you need to adjust EOTF. For detailed 

operations, please refer to Adjust EOTF. 

 

When you enable the HDR function, the receiving card supporting this function should be used 

together. For the specified receiving card model and related information, please refer to our 

official website (www.novastar.tech). 
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Configure EDID 

Configure the resolution and frame rate of the input. You can select the standard resolution 

provided by the device, customize a resolution, or set the advanced parameters. 

Applicable Products 

VC6 Pro, VC10 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

 SDI does not support this function. 

 The front-end device outputs the video source from the graphics card. 

Notes 

It is recommended the advanced settings be carried out by the trained personnel only. 

Interface Example 

Figure 3-13 Standard 

 

Figure 3-14 Custom 
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Figure 3-15 Advanced 

 

Description 

On the EDID tab interface, select the Standard, Custom or Advanced mode, configure the 

following parameters, and then click Apply after the settings. 

Mode Parameter Description 

Mode - Three modes are supported, including Standard, Custom or 

Advanced. 

Standard Resolution The number of horizontal pixels and vertical pixels of the image 

Check the box next to Display Resolution Details to display the 

resolution detailed information. 

Config method: Select the desired resolution from the drop-down 

list. 

Frame Rate The image frames every second (unit: Hz) 

Config method: Select the standard common frame rates from the 

drop-down options. The available frame rates may vary according 

to the chosen resolution. 

Custom Resolution The number of horizontal pixels and vertical pixels of the image 

Config method: Stet the width and height values respectively. 

Frame Rate The image frames every second (unit: Hz) 

Config method: Select the standard common frame rates from the 
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Mode Parameter Description 

drop-down options. The available frame rates may vary according 

to the chosen resolution. 

Advanced H Total Total pixel count per line 

H Active The horizontal size in pixels of the active area 

H Front Porch The offset between the end of the active area and the beginning of 

the H sync 

H Sync The horizontal sync width in pixels (or between pixels) 

H Polarity The polarity of the horizontal sync pulse 

V Total Total pixel count per column 

V Active The vertical size in pixels of the active area 

V Front Porch The offset in lines between the end of the active output area and 

the beginning of V sync 

V Sync The vertical sync width in rows (or between rows) 

V Polarity The polarity of the vertical sync pulse 

Frame Rate The image frames every second (unit: Hz) 

Config method: Select the standard common frame rates from the 

drop-down options or set the frame rate value. 

Configure Compatibility with Mac 

When the device is incompatible with the EDID of a Mac system, you may activate this feature 

to resolve the issue. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 
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Notes 

None 

Interface Example 

 

Description 

Parameter Description 

Mac EDID Compatibility Turn on or turn off the function. 

 : On 

 : Off 

Import and Export EDID 

When compatibility problem occurs on an input connector, import an intact EDID file into the 

device; or export an EDID file from a device and provide the EDID file to other devices or input 

connectors to solve the compatibility issues. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

SDI does not support this function. 

Notes 

 Each input connector supports importing one EDID file only. 

 Once the EDID file is imported, the input connector will recognize and apply the parameters 

from the file. 
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Interface Example 

 

Description 

 EDID Import 

On the EDID tab interface, click EDID Import. In the dialog box that appears, select an EDID 

file and click Open. 

 EDID Export 

On the EDID tab interface, click EDID Export. In the dialog box that appears, select a path 

and click Save. 

 

If you need to modify the content of an imported EDID file, just modify it and then re-import it to 

overwrite the original one. 
 

Configure Output Properties 

Set OPT Ports 

Set the OPT working mode and loop mode. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

The device working mode is set to Video Controller. 

Notes 

None 
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Interface Example 

 

Description 

Click the OPT port on the device rear panel, and then set the following parameters. 

Table 3-1 OPT working mode 

Device Model Parameter Description 

VX400 Pro OPT 2 Working 

Mode 

OPT 2 working mode 

Config method: Select Copy or Backup from the drop-down 

list. 

 Copy: OPT 2 copies the output on Ethernet port 1~4. 

 Backup: OPT 2 backs up the output on Ethernet port 1~4. 

VX600 Pro OPT 2 working mode 

Config method: Select Copy or Backup from the drop-down 

list. 

 Copy: OPT 2 copies the output on Ethernet port 1~6. 

 Backup: OPT 2 backs up the output on Ethernet port 1~6. 

VX1000 Pro OPT 2 working mode 

Config method: Select Copy or Backup from the drop-down 

list. 

 Copy: OPT 2 copies the output on Ethernet port 1~10. 

 Backup: OPT 2 backs up the output on Ethernet port 

1~10. 

VX2000 Pro OPT 3/4 Working 

Mode 

OPT 3 and OPT 4 working modes 

Config method: Select Copy or Backup from the drop-down 

list. 

 Copy: OPT 3 and OPT 4 copy the output on Ethernet port 

1~10 and 11~20 respectively. 

 Backup: OPT 3 and OPT 4 back up the output on Ethernet 

port 1~10 and 11~20 respectively. 
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 After the OPT working mode is set to Copy, the OPT ports on the graphical device panel will be 

highlighted. 

 After the OPT working mode is set to Backup, the backup icons will be displayed at the bottom 

right corner of the OPT ports on the graphical device panel. 
 

Table 3-2 OPT loop mode 

Device Model Parameter Description 

VX400 Pro/VX600 

Pro/VX1000 

Pro/VX2000 Pro 

OPT Loop Mode Turn on or turn off the function. 

 On:  

After this function is enabled, the video signal accessed 

by OPT 1 will be looped out via OPT 2. 

 Off:  

Set Monitoring 

Real-time display of the output image via the monitor connected is supported. You can monitor 

whether the output is normal and adjust the display ratio of the monitoring image on the 

monitor to avoid image distortion. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

 Only the VX2000 Pro supports the setting of the monitoring image definition. 
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Interface Example (VX2000 Pro) 

 

Interface Example (VC6 Pro) 

 

Description 

Click the Monitor connector on the device rear panel, and then set the following parameters. 

Parameter Description 

Scaling Mode The options include Keep Ratio and Full Screen (default). 

 Keep Ratio: Keep the ratio of the original output image to display. 

 Full Screen: Display the output image in full screen. 

 

When Keep Ratio is selected, the blank area that the output image cannot 

cover the entire monitor screen will be automatically filled with solid black. 

Definition The supported options include Smooth and High-Definition. 

 Smooth: The monitoring image definition is 1920×1080@60Hz. 

 High-Definition: The monitoring image definition is 3840×2160@60Hz. 

Screen Configuration 

Configure Sub-Screens 

When a single device is used to load to multiple physical screens (for example, to display the 

same or different content simultaneously on multiple welcome screens or information screens), 

the sub-screen function can be enabled. By configuring an independent sub-screen for each 

physical screen, their display effects can be controlled separately. 
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Add Sub-Screens 

Configure an independent sub-screen for each physical screen, allowing for independent 

control of the images and effects on each screen. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

Up to 5 sub-screens can be created. 

Interface Example 

 

Description 

Click Sub-Screen at the top right corner, and then click New Sub-Screen in the popup menu to 

add a sub-screen. The default name is Sub-Screen 1. 

 

If you have configured the screen topology before adding a sub-screen, the configured cabinets 

will be automatically assigned to the first created sub-screen by default. 
 

In the sub-screen list, you can perform the following operations. 
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 Change name: Hover the mouse over the target sub-screen, and then click  that appears. 

Enter a new name, and then click elsewhere in the interface to complete the sub-screen 

name change. 

 Delete sub-screen: Hover the mouse over the target sub-screen, and then click  that 

appears. In the popup dialog box, click OK to delete the sub-screen. 

 

 When deleting a sub-screen, its configured cabinets will also be deleted. Please proceed 

with caution. 

 When deleting the last sub-screen, its screen topology will be saved to the initial screen. 
 

Set Sub-Screens 

For a sub-screen, you can perform related operations, including screen topology configuration, 

cabinet correction and screen adjustment, realizing independent control of each physical 

screen. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

 If you use the quick configuration function to configure the LED screen on the device LCD 

panel, all sub-screens created in Unico will be cleared. 

 You can add, delete or rename a sub-screen on the Screen interface only. For switching or 

configuring the sub-screen, please perform the related operations on the Correction or 

Screen Settings interface. 
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Interface Example 

 

Description 

Click Sub-Screen at the top right corner , and then select the target sub-screen to switch to it. 

After switching to the target sub-screen, you can configure the screen topology, correct the 

cabinet and adjust the screen on the Screen, Correction or Screen Settings interface 

respectively. For detailed operations, please refer to the related sections in this manual. 

 

 On the Screen interface, cabinets configured for all sub-screens will be displayed, and the 

cabinets of the current screen will be displayed at the top and can be selected; while, 

cabinets of other sub-screens will be displayed in gray at the bottom and cannot be 

selected. 

 On the Correction and Screen Settings interfaces, only cabinets of the current sub-screen 

will be displayed. 

 On the Screen Settings interfaces, click Sub-Screen at the top right corner, and then select 

All in the popup menu to adjust the related parameters, such as brightness and Gamma, for 

all sub-screens. 
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Configure Screen Topology 

Configure the cabinet topology to complete the wiring connections of the physical or empty 

cabinets. 

Configure Online Cabinets 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

The device is connected and cabinets are connected to the device. 

Notes 

None 

Description 

Step 1 Click Screen at the top to enter the screen configuration interface. 

Figure 3-16 Screen configuration (VX2000 Pro) 
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Figure 3-17 Screen configuration (VC6 Pro) 

 

Step 2 Select the desired screen from the screen list on the left. 

Step 3 In the Ethernet Port List area, select an Ethernet port and then drag and click the mouse in the 

topology area to add cabinets. 

The cabinets will be automatically connected when you are adding them, as shown in Figure 3-

18. The Ethernet port's loading capacity information will be displayed, as shown in Figure 3-19. 

Figure 3-18 Cabinets connected automatically 

 

Figure 3-19 Ethernet port capacity 

 

 1: The Ethernet port number 

 2/8: Configured cabinets loaded by this Ethernet port/Total cabinets loaded by this Ethernet 

port 
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 20% and progress bar: Loading capacity used by the configured cabinets/Total loading 

capacity of this Ethernet port 

 

Descriptions for shortcut keys: 

 Batch select cabinets: Hold the Shift key and drag with the left mouse button to select, or 

simply drag the mouse to select multiple cabinets at a time. 

 When no Ethernet ports are selected, use the arrow keys to finely adjust the position of the 

selected cabinet. Each press moves the cabinet by 1 pixel. 

Description for Swift Layout: 

 Requirements: If all the cabinets loaded by the Ethernet ports have the same model, resolution, 

and connection topology, you can use the Swift Layout function to quickly add and connect 

the cabinets for all the Ethernet ports. 

 Operating procedure: Click  and then drag the mouse in the topology area to add 

cabinets that match the actual requirements. In the properties area, select a layout and click 

Done. 
 

Step 4 Select other Ethernet ports and continue to add cabinets until all cabinets are connected. 

 

The configured cabinets can be rewired by selecting other Ethernet ports to load them. 
 

Step 5 For cabinets that have the same size and consecutive serial numbers, if you want to change the 

cabinet connection topology, select the cabinets and then select a quick topology under Quick 

topo in the properties area, as shown in Figure 3-20. For other cabinets, skip this step. 

Figure 3-20 Quick topology 

 

Step 6 Do any of the following to arrange and align the cabinets and cabinet groups to let the cabinet 

positions meet the display requirements. 

 Use the function buttons. 
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− Zoom to Selection: The selected element is zoomed and displayed in the center of the 

canvas. 

− Auto Fit: The canvas size is automatically adjusted to fit the topology area size. 

− Click  to show its drop-down menu shown below. The menu can be used to set the 

canvas grid. 

 

Grid: When toggled on ( ), a grid is displayed on the canvas. If you do not need to 

display the grid, set the switch to . 

Grid Color: Set the grid color. 

Grid Spacing: Set the spacing of horizontal and vertical lines of the grid. The spacing is 

set to the resolution of the first cabinet by default. 

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being 

moved will automatically align and snap to the edge of the adjacent cabinet, effectively 

eliminating gaps. 

Snap to Grid: The cabinet will be snapped to the grid. 

 Use the right-click function menu 

− Select String: Select all the cabinets on the connection line of the current cabinet. 

− Select Same Cabinets: Select the cabinets of the same model of the current cabinet. 

− Blackout: Blackout the output image displayed on the current cabinet. 

− Freeze: Freeze the output image displayed on the current cabinet. 

− Swap: Swap the positions of the two selected cabinets. 

− Group: Select the desired cabinets and right click on them. Click Group in the context 

menu, and then the selected cabinets will be grouped for batch control. To set the 

group name and color, please select the group and set them in the properties area. You 

can also use the keyboard shortcuts Ctrl+G to perform the grouping operation. 

− Ungroup: Ungroup the cabinets. You can also use the keyboard shortcuts Ctrl+Shift+G 

to perform this action. 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 48 
 

− Add to: Add the selected cabinets to a group. 

− Clear Topology: Clear the current cabinet topology. 

− Delete: Delete the selected cabinet. You can also use the keyboard shortcuts Del to 

perform this action. 

 Right click on the canvas edge and use the function menu 

 

− Zoom to Selected: The selected element is zoomed and displayed in the center of the 

canvas. 

− Fit Screen: The canvas size is automatically adjusted to fit the topology area size. 

− Zoom 1:1: The canvas size equals the input source resolution. 

− Display Grid: Display a grid on the canvas. 

− Snap to Grid: The cabinet will be snapped to the grid. 

− Snap to Cabinet: When positioning a cabinet near another one, the cabinet being 

moved will automatically align and snap to the edge of the adjacent cabinet, effectively 

eliminating gaps. 

− Display Topology: Display the cabinet connections. 

− Display Status: Display the cabinet status. 

Green: The cabinet is in the topology area. 

Gray: The cabinet is offline. 

Orange: Some part of the cabinet is in the topology area. 

Red: The entire cabinet is out of the topology area. 
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− Display Cabinet Color: Display a color icon at the top right corner of an Ethernet port. 

Once an Ethernet port is loading cabinets, a color icon will be displayed which is of the 

same color as the cabinet color. 

− Display Group Name: Display the cabinet group name. 

− Display Overlapping Cabinets: Display the overlapping cabinets. 

Figure 3-21 Online cabinet topology (VX2000 Pro) 

 

Figure 3-22 Online cabinet topology (VC6 Pro) 

 

 

 Use either Unico or NovaLCT to configure the screen. 
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 Mapping is used to show the relations between the cabinets of the LED screen and the 

sending devices so that you can view or check the connections between the cabinets. 

 Click LCT Lite to run the software in which you can configure the receiving card parameters. 

 In the menu bar, go to File > Export Screen Config File to export the configured cabinet 

topology as a file (.scr). 

 In the menu bar, go to File > Import Screen Config File to import a saved screen configuration 

file for quick topology. 
 

Configure Empty Cabinets 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Description 

Step 1 Click Screen at the top of the page to enter the screen configuration page. 
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Figure 3-23 Screen configuration (VX2000 Pro) 

 

Figure 3-24 Screen configuration (VC6 Pro) 

 

Step 2 Select the desired screen from the screen list on the left. 

Step 3 Click Add Cabinet. 
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Figure 3-25 Add cabinets 

 

Step 4 Select the desired cabinet existing in the cabinet library from the drop-down list below Select 

Mode. 

Step 5 (Optional) If no cabinet configuration files (.rcfgx) are imported to the cabinet library, you can 

set the width and height for the empty cabinet. 

Step 6 Set the rows and columns of cabinets. After settings are done, click OK to confirm. 

Step 7 In the topology area, click the left mouse button to add cabinets with the set rows and columns. 

Figure 3-26 Add empty cabinets (VX2000 Pro) 
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Figure 3-27 Add empty cabinets (VC6 Pro) 

 

Step 8 Select the desired Ethernet port and drag or click the mouse in the empty cabinets to complete 

the wiring. 

 

Descriptions for screen topology: 

 Use format painter. 

Method I: Select an Ethernet port first, and then select the desired data flow. The cursor will 

change to a format painter icon. Drag the mouse in the empty cabinets to automatically 

complete the wiring according to the selected data flow. 

Method II: Select the desired data flow first, and the cursor will change to a format painter 

icon. Then, select an Ethernet port and drag the mouse in the empty cabinets to complete 

the wiring according to the selected data flow. 

 Drag the mouse to complete the wiring. 

After selecting an Ethernet port, there is no need to choose the data flow. Simply drag the 

mouse in the empty cabinets, and the system will automatically complete the wiring 

according to the mouse movement. 

 Quick topology 

Select one or multiple empty cabinets, select the desired data flow, and then select the 

target Ethernet port to complete the wiring. 

 Use arrow keys. 

Select an Ethernet port and confirm the wiring starting position, and then use arrow keys to 

control the wiring path. 
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Step 9 Select other Ethernet ports and continue wiring until all cabinets are connected. 

Figure 3-28 Empty cabinet topology (VX2000 Pro) 

 

Figure 3-29 Empty cabinet topology (VC6 Pro) 

 

Cabinet connection status: 

 P1: The cabinet is loaded by Ethernet port 1. 

 NC: An empty cabinet 

Step 10 Connect the on-site cabinets based on the configured topology. 
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When configuring the empty cabinet, you can leave the desired cabinet without wiring as shown 

below based on the on-site screen loading requirements. 

 
 

Configure Screen Properties 

Set the screen-related properties in the property area on the right pane. 

Rename Screens 

Change the screen name. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Interface Example 
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Description 

On the Basic tab interface, change the screen name as required. 

Configure Low Latency 

When the input source travels from where it comes to the processing device, sending device 

and then the receiving card, latency exists inevitably. Turning on this function can effectively 

help to reduce the latency from the input to output. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

If you set the low latency mode to Auto, the system will determine whether to enable the low 

latency based on the screen topology. The specific rules are as follows. 

 For a single Ethernet port with vertical cabling and no overlap in the Y direction, the low 

latency will be automatically enabled if all the following requirements are met; otherwise, it 

will be disabled. 

− The cabinets loaded by one Ethernet port cannot be overlapped, while blank 

configurations are allowed. 

− The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas. 

− No need to keep the same cabinet size. 
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 For free topology, the low latency will be automatically enabled if all the following 

requirements are met; otherwise, it will be disabled. 

− The cabinets loaded by one Ethernet port cannot be overlapped, while blank 

configurations are not allowed. 

− The circumscribed rectangles of all cabinets loaded by Ethernet ports must be aligned 

at the top of the canvas. The size of the circumscribed rectangle cannot exceed 650,000 

pixels. 

− The size of all cabinets must be the same. 

Interface Example 

 

Description 

Parameter Description 

Low Latency Turn on of turn off the function. 

 Off: Turn off the function. (Default option) 

 On: Turn on the function. The device latency can be reduced by 1 frame. 

 

After you manually enable the low latency function, it is advisable to align the 

circumscribed rectangle loaded by each Ethernet port at the top of the canvas. If 

not aligned, the loading capacity will be reduced. For calculating the actual loading 

capacity, please refer to Loading Capacity Calculation Method in Low Latency 

Mode. 

 Auto: If you set the low latency mode to Auto, the system will determine 

whether to enable the low latency based on the screen topology. If the wiring 
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Parameter Description 

meets the rules, low latency will be enabled automatically; otherwise, it will be 

disabled automatically. For specific rules, please refer to the notes in this 

section. 

Set Canvas Size 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Interface Example 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Resolution The size of the canvas, that is the size of the device effective loading area 

Config method: 

 Select the desired resolution from the drop-down list. 

 Select Custom from the drop-down list, and then set the width and height 

values. 

Generally, the size of the effective loading area should match with that of the 
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Parameter Description 

physical screen. 

After you complete the settings, the system will automatically calculate the max 

output frame rate at the current resolution. 

Match Screen After the screen configuration is completed, click Match Screen and the system 

will automatically change the canvas size to the size of the circumscribed 

rectangles. 

Configure Test Patterns 

Test patterns are used to check the connection relation between the output connectors and the 

screen, and check whether the screen display is good. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Test Pattern Turn on or turn off the function. 

 : On 

 : Off 

After the function is enabled, select the desired test pattern. 

Grayscale Set the grayscale of the test pattern. 

Spacing Level Set the spacing between different color areas. 

If a multi-color test pattern is selected, this parameter is available. 

Spacing (px) Set the spacing between the lines. 

If a grid test pattern is selected, this parameter is available. 

Grid Width Set the width of the grid lines. 

Speed Set the moving speed of the lines. 
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Configure Output Color 

Configure the output color parameters. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

On the Effect tab interface, configure the following parameters. 

Parameter Description 

Contrast The ratio of the luminance of the brightest color to that of the darkest color 

Adjust the contrast value either as a whole or individually adjust the RGB 

components. 

Brightness The shading of lights in the image 

Adjust the brightness value either as a whole or individually adjust the RGB 

components. 

Hue The relative degree of how bright or dark the image is 

Saturation The color purity of the image 

The higher the value, the more vivid the color. 
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Configure Cabinet Properties 

View Cabinet Library 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Interface Example 

 

Description 

View the online cabinets or cabinet configuration files in the cabinet library. 

Click Add to upload the cabinet file to the local pack or device pack, or add the virtual cabinet 

to the local pack. For detailed operations, please refer to Manage Cabinet Library. 
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Change Cabinet Resolutions 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

The changed resolution of the configured cabinet should be a multiple of the module resolution 

to ensure normal display. 

Interface Example 

 

Configuration 

Select the desired cabinet in the canvas area, and then set the cabinet width and height on the 

Cabinet Properties tab interface. After settings are done, click OK to complete the editing. 

View Cabinet Info 

View cabinet-related info. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

None 

Notes 

None 

Interface Example 

 

Description 

None 

Configure Cabinet Groups 

Change the cabinet group name and background color. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

A cabinet group has been created. 

Notes 

None 

Interface Example 

 

Description 

On the Cabinet Properties tab interface, configure the following parameters. 

Parameter Description 

Group The name of the cabinet group 

Config method: Enter a new group name, and then click elsewhere in the 

interface to complete the group name change. 

Color The background color of the group name 

Config method: Click the color block next to Color, and then select a standard 

color or enter RGB values to set the background color of the cabinet group name. 

Configure Cabinet Positions 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 67 
 

Notes 

The cabinet rotation in 90° increments feature is only supported by certain models of receiving 

cards, as detailed below: 

Model Description 

CA50E, XA50Pro, A10s Pro Supported by all versions. 

A8s-N, A7s Plus, A5s Plus Supported by V4.9.0.0 or later. 

Interface Example 

 

Description 

On the Cabinet Properties tab interface, configure the following parameters. 

Parameter Description 

Coordinate The position of the cabinet on the canvas 

 X: X coordinate of the cabinet on the canvas 

 Y: Y coordinate of the cabinet on the canvas 

Rotation (0°) Rotate the cabinet. Once the cabinet is rotated, the input source will display at 

the adjusted angle. 

Supported rotation angles: 0°, 90°, 180° and 270° 

Set Cabinets 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 
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Notes 

None 

Interface Example 

 

Description 

On the Cabinet Properties tab interface, configure the following parameters. 

Parameter Description 

Blackout Turn on or turn off the function. 

 : On 

 : Off 

Freeze Turn on or turn off the function. 

 : On 

 : Off 

Indicator Turn on or turn off the function. 

 : On 

 : Off 

Light up slowly Turn on or turn off the function. 

 : On 

 : Off 

Once enabled, the display brightness will slowly change from 0 to the target value 

after the screen is powered on. 

Test Pattern Select a test pattern to perform screen aging test and troubleshoot problems. 

No data signal Set the display image after the Ethernet cable is disconnected. 

 Blackout: The screen displays a black image. 

 Previous Frame: The screen always displays the last frame. 
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Configure Ethernet Port Backup 

Test whether the pre-stored images, backup Ethernet ports and devices take effect without 

plugging and unplugging the Ethernet cables. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

The pre-stored images, primary and backup Ethernet ports or primary and backup devices have 

been configured. 

Notes 

None 

Interface Example 

 

Description 

On the Cabinet Properties tab interface, configure the following parameters. 

Parameter Description 

Port Backup Turn on or turn off the function. 

 : On 

 : Off 

Backup Verify Select the desired backup test. 

 Off: Enable the output of all the Ethernet ports on the current device to 

complete the test. 

 Backup: Disable the output of the primary Ethernet port on the current device 

to test whether the backup port or device takes effect. 

 Primary: Disable the output of the backup Ethernet port on the current device 
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Parameter Description 

to test whether the output of the primary port is normal. 

 Disconnect All: Disable the output of all the Ethernet ports on the current 

device to test whether the pre-stored image takes effect. 

 

After enabling Ethernet port backup, a  icon is displayed between the primary and backup 

ports in the Ethernet port list. By default, the first half of the ports serve as backups for the 

second half. 
 

Set Dual RV Cards Backup 

Receiving card backup allows you to set the backup relationship between two receiving cards. If 

the primary receiving card link fails, the backup one will take over the responsibilities of the 

primary receiving card and continue to work well to ensure the LED screen will not go black. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

Two receiving cards are connected to the cabinet. 

Notes 

When you enable both the device backup and dual receiving cards backup, the former takes 

precedence over the latter. When the layer sources of two devices are disconnected, the device 

will switch to the backup receiving card link. 

Interface Example 
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Description 

Parameter Description 

Dual RV Cards Backup Turn on or turn off the function. 

 : On 

 : Off 

Screen Correction 

Correct Seams 

Adjust the seams between cabinets or modules to improve the display effect. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

You have configured the cabinets. 

Notes 

None 

Description 

Step 1 Select Correction at the top of the page. 
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Figure 3-30 Screen correction 

 

Step 2 On the Seams tab in the properties area, toggle the Brightness Calibration switch to . 

 

 Only the specific receiving cards support the Seam Correction switch, including the A8s Pro, 

NV7508, NV7512, NV7516, DH7508-S, DH7512-S, DH7516-S and MRV208-NB7s. The 

adjustment of bright and dark lines can be controlled independently of the coefficients. 

When turned off, the bright and dark lines cannot be adjusted, and any previously made 

adjustments will not be displayed. 

 Apart from the above-mentioned receiving cards, the Seam Correction switch will not be 

displayed on this interface. In this case, simply toggling on the Brightness Calibration or 

Brightness and Chroma Calibration will ensure that the seam correction takes effect. 
 

Step 3 Toggle on Brightness Calibration or Brightness and Chroma Calibration to view the 

correction effect. 

 Brightness Calibration: Set the Brightness Calibration switch to  to make the screen 

apply the calibration effect made by the calibration platform. 

 Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration switch to 

 to make the screen apply the calibration effect made by the calibration platform. 

The Brightness Calibration and Brightness and Chroma Calibration are mutually exclusive. 
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Figure 3-31 Correction (seams) 

 

Step 4 Select a correction mode. 

Figure 3-32 Select mode (seams) 

 

 Cabinet Seams: Correct the seams of cabinets. 

 LDM Seams: Correct the seams of modules. 

 

You can use the corresponding shortcut keys to quickly select the target one. For example, press 

F1 to select all outer border lines of the cabinet. 
 

Step 5 When correcting the module seams, if you need to override the numbers of module columns 

and rows, click the  icon next to Select Mode and then perform the settings on the Cabinet 

Structure Override window. Otherwise, skip this step. 

Figure 3-33 Cabinet structure override 

 

Step 6 Set the screen display parameters and check the seam correction effect. 
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Figure 3-34 Adjustment (4-color) 

 

 Brightness: Adjust the display brightness. 

 Display image: Set the image displayed on the screen. By default, the current input source is 

being displayed ( ). You can switch to a monochrome display. 

 

You can use the corresponding shortcut keys to switch between various images. For example, 

press W to switch to white image display. 
 

Step 7 In the topology area, click or click and drag the mouse to select the seams to be corrected. 

Step 8 Set the adjustment parameters. 

Figure 3-35 Set the parameters 

 

 Quick adjust: Has a large range of adjustment. 

 Fine Adjust: Has a fine range of adjustment. 

 Hide the cursor while adjusting: When this is enabled ( ), the cursor will not be displayed 

on the screen while adjusting brightness and chroma. 

Step 9 Place the mouse on the scroll wheel icon and adjust the brightness by dragging the wheel icon 

up or down, scrolling the mouse wheel, or using the keyboard shortcuts 1+↑/↓. 

 Restore: Restore the configuration to the last saved. 
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 Reset: Reset the configuration to factory defaults. 

Step 10 After the settings, click Save. 

Erase Seam Correction 

If there are any changes made to the cabinets, such as moving a receiving card from one 

cabinet to another or replacing the cabinet module, it may cause bright or dark lines that had 

been previously corrected to appear in the middle of the cabinet or module. In such cases, you 

have the option to remove the seam correction that was applied. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

You have configured the cabinets. 

Notes 

None 

Description 

Step 1 Select Correction at the top of the page. 

Step 2 Select the Cabinet mode. 

Figure 3-36 Select mode (cabinet) 

 

Step 3 Select the target cabinets and then click Erase to remove the seam correction that was applied 

to them. The erasion will be automatically saved to the hardware once you are done. 
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Figure 3-37 Erase seam correction 

 

Screen Settings 

Adjust Image Quality 

Adjust Brightness and Gamma 

Adjust the Gamma value and brightness of the output to enhance the overall image quality of 

the LED screen. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

Select Screen Settings at the top of the page, and then on the Image Quality tab interface, 

configure the following parameters. 

Parameter Description 

Brightness The brightness of the LED screen 

Gamma Adjust the ratio of the screen brightness to the input level. The parameters are 

read from the receiving card, which default to optimal values at the factory. It is 

recommended the parameter adjustment be carried out by the trained personnel 

when necessary. 

Set LED Image Booster 

Set the LED Image Booster function to improve the delicacy and accuracy of the image color 

and gradation and realize free switching of the display color gamut. 

Applicable Products 

VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

Before the operation, color gamut and brightness correction by using the CA410-VP427, 

CA410-P427 or CA410-P427H colorimeter must be done. 

Notes 

None 
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Interface Example 

 

Description 

Parameter Description 

Gamut The color gamut standard 

The output gamut options include standard 

gamuts, custom gamuts, the original screen 

gamut and the input gamut (From input). 

To set the custom gamut, click , select a 

gamut in the properties area on the color gamut 

diagram, and adjust the red, green, blue and 

white parameters based on the selected gamut. 

Color Temperature Drag the slider to adjust color temperature. 

Magic Gray Turn on or turn off the function. 

 : On 

 : Off 

Adjust EOTF 

Applicable Products 

VX2000 Pro 

Prerequisites 

None 
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Notes 

The supported adjustment parameters depend on the HDR source settings. 

Interface Example 

 

Description 

On the Image Quality tab interface, drag the sliders to adjust the related parameters. 

Parameter Description 

Shadow Compensation Adjust this parameter to enhance the image display effect. The greater the 

value, the clearer the details in the shadow area. 

Range: 0 to 100 (default: 33), Step: 1 

Ambient Light 

Compensation 

Adjust this parameter to reduce the loss of image details caused by ambient 

light diffusion. 

Range: 0 (default) to 80 , Step: 1 

Clip Level Adjust the parameter to reduce the screen overexposure and enhance 

details of the highlight areas. 

Range: 0 (default) to 100 , Step: 1 

Override Peak Screen 

Brightness 

Turn on or turn off the function. 

 On:  

 Off:  

Peak Screen Brightness Adjust the brightness of the screen when it is functioning normally. 

When Override Peak Screen Brightness is enabled, this parameter can be 

adjusted. Range: 100 to 10000 nits (default: 1000 nits), Step: 1 
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Adjust Output 

Set Output Bit Depth 

Applicable Products 

VX2000 Pro 

Prerequisites 

None 

Notes 

When you use the HDR function, setting output bit depth to 10bit is required to achieve optimal 

display effect. 

Interface Example 

 

Description 

On the Output tab interface, configure the following parameters. 

Parameter Description 

Bit Depth Set the output bit depth. 

The supported options include 8bit and 10bit. 

Configure 3D 

Directly connect a third-party 3D emitter using the device's built-in 3D connector, or connect to 

the EMT200 Pro emitter via the device's Ethernet port. Then, use the compatible 3D glasses to 

achieve a 3D display effect. 
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Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

 Video source format: Side-by side, top-and-bottom or frame sequential 

 When paired with the EMT200 Pro, it is recommended to use a 3D source of 60Hz to enjoy 

an optimal experience. 

Notes 

 When the 3D function is enabled and the video source format is Side-by-Side or Top-and-

Bottom, the device output capacity will be halved. 

 When the 3D function is enabled and the video source format is Frame Sequential, you need 

to manually set the output frame rate which must be the same as the input frame rate. 

 The 3D function and input cropping cannot be enabled at the same time. 

 After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will 

be toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired 

layer in the property area of the Programming page. 

 The 3D effect follows the layer. The output area where a 3D layer is located always displays 

the 3D effect. 

Interface Example 

 

Description 

On the Output tab interface, configure the following parameters. 

Parameter Description 

3D Turn on or turn off the 3D function. 
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Parameter Description 

 : On 

 : Off 

Source Format The format of the 3D video source 

Set the format to Side-by-Side, Top-and-Bottom or Frame Sequential according to 

the format of the accessed video source. 

Eye Priority Set which image is sent first, the right eye image or the left eye image. 

Put on the 3D glasses to view the screen. If the display appears abnormal, adjust the 

parameter value to the other one. If the display is normal, no further adjustments are 

needed. 

3rd Emitter Turn on or turn off the function. 

 : On 

 : Off 

Signal Delay Set the delay time of sending the synchronization signal from the 3D signal emitter to 

the 3D glasses. This setting ensures that the switching between left and right eye 

images of the 3D glasses is in sync with the switching between the left and right eye 

images on the screen. This parameter is applicable to both the NovaStar and third-

party emitters. 

Check Load 

Check the capacity usage of each Ethernet port of the device. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example 

 

Description 

On the Output tab interface, click  next to the device information to check the usage of the 

device loading capacity. 

Layer Operations 

Add Layers 

Add layers to screen 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

Make sure the device is in Video Controller mode before adding layers. 

Notes 

The maximum number of layers that can be added depends on the connected device. 

Device Model Number of Supported Layers (2K×1K) 

VX400 Pro 6 

VX600 Pro 

VX1000 Pro 

VX2000 Pro 12 
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Device Model Number of Supported Layers (2K×1K) 

VC6 Pro 6 

VC10 Pro 6 

VC16 Pro 12 

Description 

Step 1 Click Programming at the top of the page to enter the layer editing page. Select the desired 

screen from the left screen list, and then click the Input tab. 

Figure 3-38 Programming (VX2000 Pro) 
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Figure 3-39 Programming (VC6 Pro) 

 

Step 2 Add the layers to the screen. 

Drag an input source in the input list to the screen. 

Step 3 Perform the desired layer operations as required. 

Figure 3-40 Layer operations 

 

Configure Video Source Properties 

In the input list, select an input source and set the relevant properties on the right pane. For 

detailed configurations and parameter descriptions, please refer to Configure Input Properties. 
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Mosaic Source Settings 

Both HDMI and OPT sources support mosaicing. 

View Mosaic Source Info 

View the basic properties of the mosaic source and change the source name. 

Applicable Products 

VX2000 Pro 

Prerequisites 

A mosaic source has been configured and its signal is fine. 

Notes 

None 

Interface Example 
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Description 

On the Mosaic Source tab interface, type in a new source name and click anywhere else on the 

interface to save the change. 

Configure Mosaic Sources 

Set the mosaic source name, sub-source type, mosaic layout as well as sub-source size. 

Applicable Products 

VX2000 Pro 

Prerequisites 

None 

Notes 

Only the input sources of the same connector type support mosaicing, and the frame rates of 

sub-source must be the same. 

Interface Example 

 

Description 

On the Edit Mosaic tab interface, configure the following parameters. 

Parameter Name Description 

Name The name of the mosaic source 
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Parameter Name Description 

Source Type The type of the sub-sources 

Config method: Select HDMI 1.3, HDMI 2.0 or OPT from the drop-down list. 

Layout The layout of the mosaic source 

Config method: Select the desired layout from the standard layout template, and 

then drag the inputs in the input list to the sub-cells respectively. 

Sub-Source Size The size of the sub-sources 

 Default width: 1920 pixels, max width: 8192 pixels 

 Default height: 1080 pixels, max height: 8192 pixels 

 Max width and height: 4096×2160 

Configure USB Source Properties 

Select a USB source in the input list and configure relevant properties on the USB Playback 

Settings tab interface. 

The models of devices that support USB playback and the corresponding output resolutions for 

USB sources are listed below. 

Device Model USB Source Resolution 

VX400 Pro 1920×1080@60Hz 

VX600 Pro 

VX1000 Pro 

VX2000 Pro 3840×2160@60Hz 

VC6 Pro 1920×1080@60Hz 

VC10 Pro 

VC16 Pro 3840×2160@60Hz 

Play USB Files 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

The U-DISK connector on the front panel is inserted with a USB drive which is successfully 

identified. 

Notes 

None 

Interface Example 

 

Description 

In the playlist, select a file to play it and you can also stop the playback, play the previous or 

next file as well as set the playback mode. 

Configure Playback Parameters 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

The U-DISK connector on the front panel is inserted with a USB drive which is successfully 

identified. 

Notes 

 Single-partition USB drive supported 
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 File system: NTFS, FAT32 and exFAT 

 Max. width and height of media files 

Width: 3840 pixels, height: 2160 pixels 

 Picture format: jpg, jpeg, png and bmp 

 Decoded image resolution: 3840×2160 or lower 

 Video format: mp4, mkv, mov, avi, flv, m4v, mpg, mpeg, ts 

 Video coding: H.264, H.265, MPEG-2, MPEG-4 

 Max. video frame rate: 

H.264: 3840×2160@30fps, H.265: 3840×2160@60fps 

MPEG-2/MPEG-4: 1920×1080@60fps 

 Max bitrate: 

H.264/H.265: 100Mbps 

MPEG-2/MPEG-4: 50Mbps 

 Audio coding: AAC, AC3, DTS, MP3, DVD, DVD_LPCM, MP2, OPUS 

 Audio sampling rate: 

opus: 24kHz, 48kHz 

Other formats: 22.05kHz to 94kHz 

Interface Example 

 

Description 

On the USB Playback Settings tab interface, configure the following parameters. 
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Parameter Description 

Playback Mode The playback mode of the file 

 Repeat: Play the files in the playlist in order. Once the playback of 

the last file is completed, replay the first file. 

 Repeat in Order: Play the files in the playlist in order. Once the 

playback of the last file is completed, the screen will display a black 

image and the playback will stop. 

 Repeat One: Loop playback of the current file. 

File Type The type of the playback file 

 Video 

 Image 

 All: Videos and images 

 

After the file type is selected, only the file of the selected type will be 

displayed in the playlist. 

Playback Duration The duration of the image playback 

The value ranges from 1 to 60 and it defaults to 5. (Unit: s) 

Trans Effect The trans effect of the image 

Supported trans effect: Ripple, zoom in, cut out, flip, blinds, H wipe, V 

wipe, cube, dissolve, grid, swapping, scroll, fade in/out, twirl, heart 

trans, doorway, perspective triangle, disappear, bounce, pinwheel and 

random. 

Trans Duration The trans duration of the image 

The value ranges from 0.5 to 2 and it defaults to 0.5. (Unit: s) 

Auto Playback The auto playback switch 

Set whether to automatically play the USB files after the device is 

powered off and then power on with a USB drive inserted. 

 : On 

If Resume Playback not enabled, replay the files in the playlist in 

order; If enabled, replay the file being played before power failure 

from the beginning. 

 : Off 

Resume Playback Turn on or turn off the function. 

 : On 

If a file is playing before the device power failure, enabling this 

function allows to replay the file from beginning after the device is 
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Parameter Description 

powered on with a USB drive inserted. 

 Off: 

Replay the files in the playlist in order. 

 

 Enabling Resume Playback will also activate the Auto Playback 

feature at the same time. 

 After Resume Playback is enabled, if the file being played before 

power failure cannot be found, the files will be played from the 

beginning of the playlist in order. 

Set Audio 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example (VX2000 Pro) 

 

Interface Example (VC6 Pro) 

 

Description 

On the Programming interface, hover the mouse over  and set the following parameters in 

the popup menu. 
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Parameter Description 

Output Set the output audio. 

 Layer n: Output the audio of the current layer input source. When 

you switch the current layer input source, the audio will also be 

changed. 

 Audio In: Output the analog audio coming from an external audio 

device. When you switch the current layer input source, the audio will 

not be changed. 

 Embedded audio of an input source: Output the fixed embedded 

audio. When you switch the current layer input source, the audio will 

not be changed. 

The supported input source types include HDMI sources, DP sources, 

and USB sources. 

 

The input source audio of the layer 1 is output by default. 

Volume The output volume 

The value ranges from 0 to 100 and it defaults to 50%. 

 0%: Mute 

 100%: Output at maximum volume. 

 

Click  below Volume to enable or disable the audio. 

Set Input Source Audio 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 
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Interface Example (VX2000 Pro) 

 

Interface Example (VC6 Pro) 

 

Description 

On the Programming interface, click the Input tab to display the input source list. Hover the 

mouse over the desired input source and click . In the popup menu, set the input source 

audio to Embedded Audio or Audio In. 
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Configure Layer Properties 

Select the desired layer, and then set the layer-related properties in the property area on the 

right pane. 

Configure Basic Properties 

Configure the layer name, aspect ratio, position, size, as well as enabling the 3D effect. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

After enabling the 3D function on the Screen Settings page, 3D switches of all the layers will be 

toggled on. If you want to use a 2D layer, please toggle off the 3D switch of the desired layer in 

the property area of the Programming page. 

Interface Example 
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Description 

On the Basic tab interface, configure the following parameters. 

Parameter Description 

Name The layer name 

Aspect 

Ratio 

The ratio of the layer's width to its height 

After the aspect ratio is changed, the height of the layer remains unchanged, and the 

device automatically calculates its width. 

X The horizontal starting position of the layer on the screen 

The coordinates of the first pixel in the upper left corner of the screen are (0,0). 

Y The vertical starting position of the layer on the screen 

The coordinates of the first pixel in the upper left corner of the screen are (0,0). 

W The horizontal size of the layer 

The minimum width of a layer: 64 pixels 

H The vertical size of the layer 

The minimum height of a layer: 64 pixels 

3D Turn on or turn off the function 

 : On 

 : Off 

Crop Layer Sources 

When there are black borders or other redundant info in the input source image, the required 

picture can be retained through the cropping the input source, so as to improve the screen 

utilization. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

A fine signal is connected to the input connector. 
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Notes 

 The status and capacity of the cropped source remain consistent with the original one. 

 The input cropping and 3D functions cannot be enabled at the same time. 

Interface Example 

 

Description 

On the Advanced tab interface, configure the following parameters. 

Parameter Description 

Layer Source 

Crop 

Turn on or turn off the function. 

 : On 

 : Off 

X The horizontal start position of the cropped area relative to the original source 

Y The vertical start position of the cropped area relative to the original source 

Width The number of horizontal pixels (width) of the cropped area 

Height The number of vertical pixels (height) of the cropped area 

Configure OSD 

Both the text OSD and image OSD are supported. 
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Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

Before setting a time OSD or weather OSD, please ensure that the device is connected to the 

network to obtain the precise time and weather information. 

Notes 

 The OSD locates at the top and its priority cannot be adjusted. 

 The text OSD and image OSD cannot be enabled together. 

 The OSD function and remote control function cannot be enabled together. 

OSD Type Descriptions 

OSD Type Description 

Text OSD  Up to four text OSD presets are supported, and the preset 1 is selected by 

default. The quantity of the text components are as follows. 

− Static text OSD: 10 

− Weather OSD: 2 

− Time OSD: 2 

− Dynamic text OSD: 1 

 

The dynamic text OSD and other text components cannot be used together. 

Image OSD  Image gallery capacity: 75 MB 

 Supported image OSD formats: PNG/JPG/JPEG/BMP 

 Width and height limitations of a single image: 

− VC6 Pro/VC 10 ProVX400 Pro/VX600 Pro/VX1000 Pro: Max width × 

Max height ≤ 4096×1080, max width: 10240 pixels, max height: 8192 

pixels 

− VC16 Pro/VX2000 Pro: Max width × Max height ≤ 4096×2160, max 

width: 16384 pixels, max height: 8192 

Note: If the max width and height limitations are exceeded, you need to 

scale or crop the image in Unico, and the width and height of the cropped 
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OSD Type Description 

should be greater than 64 pixels. 

 Supports setting of the image OSD position. 

 Does not support setting of the image OSD size. 

 Does not support setting of the image OSD opacity. 

Configure Text OSD 

Step 1 In the screen list on the left, select the desired screen. 

Step 2 Click the OSD tab. 

Step 3 Toggle the OSD switch to  to enable the OSD function. 

Figure 3-41 Enable OSD 

 

Step 4 Click the Text OSD tab, and drag the desired OSD preset to the editing area. The OSD preset 1 

is selected by default. 

OSD preset-related operations: 

 Change the OSD preset name: Hover the mouse over the desired OSD preset, and then click 

 that appears. Enter a new preset name, and then click elsewhere in the interface to 

complete the preset name change. 

 Clear the OSD preset: Click  at the top right corner of the desired preset, and then click 

Yes in the popup dialog box to clear OSD components saved in the selected preset. 
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 Lock/Unlock the OSD preset: Click  at the top right corner of the desired preset to lock 

or unlock the preset. 

 Save the OSD preset: Click  at the top right corner of the desired preset, and then select 

another preset to save the OSD components from the original preset to the selected one. 

Step 5 On the right Layer pane, drag the , ,  or  icon to add a static text 

OSD, dynamic text OSD, weather OSD or time OSD. 

Step 6 Set the position and size of the OSD layer. 

 X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen. 

 Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen. 

 W: Set the OSD layer width. 

 H: Set the OSD layer height. 

Step 7 Click the created OSD layer to display the OSD configuration area on the right. 

Step 8 Set the related parameters of the added OSD component. For the parameters of each OSD 

component, please refer to the following descriptions. 

Step 9 Click Apply at the top right corner to complete the settings and display the set OSD on the 

screen. 

 

Select the desired OSD components, and then click  shown at the top right corner. In the 

popup dialog box, click Yes to delete the selected OSD component. 
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Static Text OSD 

Figure 3-42 Interface example 

 

Table 3-3 Parameter descriptions 

Area Parameter Description 

Text area - Enter the text OSD content. 

The static text OSD supports multi-line display. You can press 

Enter on the keyboard to have line breaks. 

Character Font Settings Select the desired text font from the drop-down list. 

Library  Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete 

to delete the selected fonts. 

 Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts. 

 Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library. 

Font size : Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px. 
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Area Parameter Description 

Font style  : Make the text bold or not. 

 : Italicize the text or not. 

 : Underline the text or not. 

Character spacing : Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px. 

Row spacing : Set the spacing between rows. This parameter is available 

when there are multiple rows. The value ranges from 0 to 1000 px 

and it defaults to 0 px. 

Alignment method Set the text alignment method. 

 : Align the text content with the left margin of the display 

area. 

 : Center the text content in the display area. 

 : Align the text content with the right margin of the display 

area. 

 : Align the text to the top of the display area. 

 : Center the text vertically to the display area. 

 : Align the text to the bottom of the display area. 

Layout Select the text layout direction from the drop-down list. 

The supported options include Horizontal, From Right (Vertical) 

and From Left (Vertical). 

Text position and 

size 

Set the position and size of the OSD component. 

 X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen. 

 Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen. 

 W: Set the OSD component width. 

 H: Set the OSD component height. 

Common 

properties 

Text color Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 

Background color Toggle on/off Background Color to enable or disable the 

background color settings. 
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Area Parameter Description 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 

Dynamic Text OSD 

Figure 3-43 Interface example 

 

Table 3-4 Parameter description 

Area Parameter Description 

Text area - Enter the text OSD content. 

Character Font Settings Select the desired text font from the drop-down list. 

Library  Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete 

to delete the selected fonts. 

 Delete all fonts: Click Library. In the popup window, check the 
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Area Parameter Description 

box next to Library, and then click Delete to delete all fonts. 

 Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library. 

Font size : Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px. 

Font style  : Make the text bold or not. 

 : Italicize the text or not. 

 : Underline the text or not. 

Character spacing : Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px. 

Speed Set the text scrolling speed. The value ranges from 0 (static) to 10 

(fastest). 

Direction Set the text scrolling direction. 

 From Left: The text scrolls from right to left in the display area. 

 From Right: The text scrolls from left to right in the display area. 

Text position and 

size 

Set the position and size of the OSD component. 

 X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen. 

 Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen. 

 W: Set the OSD component width. 

 H: Set the OSD component height. 

Common 

properties 

Text color Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 

Background color Toggle on/off Background Color to enable or disable the 

background color settings. 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 
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Weather OSD 

Figure 3-44 Interface example 
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Table 3-5 Parameter description 

Area Parameter Description 

Weather 

settings 

Location Click  to open the map window, where you can select the 

desired location or enter the address. Click OK to complete the 

settings. 

Refresh Set the automatic refresh interval for the weather information. The 

value ranges from 1 to 1440 minutes and it defaults to 10 minutes. 

Language Set the text language. The supported options include English and 

Chinese. 

Temperature Unit Set the temperature unit. The supported options include ℃ and ℉. 

Content Set the content to be displayed in the weather OSD. 

Check the box next to the desired content to display it in the 

weather OSD. You can also click Custom Tab to edit the default 

display content. 

Layout Display mode Set the display mode of the weather OSD. 

 Single Line: Display all items in single line. 

 Multi-Line: Display each item in single-line. 

Spacing Set the spacing between each selected content in Single Line 

display mode or set the spacing between rows in Multi-Line 

display mode. 

Text Font Settings Select the desired text font from the drop-down list. 

Library  Delete single/multiple fonts: Click Library. In the popup window, 

check the boxes next to the desired fonts, and then click Delete 

to delete the selected fonts. 

 Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts. 

 Add fonts: Click Library. In the popup window, click New to add 

the fonts saved in the local computer to the font library. 

Font size : Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px. 

Font style  : Make the text bold or not. 

 : Italicize the text or not. 

 : Underline the text or not. 

Character spacing : Set the spacing between characters. The value ranges from 0 

to 1000 px and it defaults to 0 px. 
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Area Parameter Description 

Row spacing : Set the spacing between rows. This parameter is available 

when there are multiple rows. The value ranges from 0 to 1000 px 

and it defaults to 0 px. 

Alignment method  : Align the text content with the left margin of the display 

area. 

 : Center the text content in the display area. 

  

Text position and 

size 

Set the position and size of the OSD component. 

 X: Set the horizontal distance from the top left corner of the OSD 

component to that of the screen. 

 Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen. 

 W: Set the OSD component width. 

 H: Set the OSD component height. 

Common 

properties 

Text color Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 

Background color Toggle on/off Background Color to enable or disable the 

background color settings. 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust the 

opacity. The opacity ranges from 0% (totally transparent) to 100% 

(nontransparent). 
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Time OSD 

Figure 3-45 Interface example 
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Table 3-6 Parameter descriptions 

Area Parameter Configuration 

Configuration Time zone Select the time zone from the drop-down list. 

Time offset Set the time offset value. The value ranges from -2 to +2 (unit: 

hour). 

Content Language Set the text language. The supported options include English 

and Chinese. 

Date Display or hide the date. 

 : Display the date. 

 : Hide the date. 

Year format Set the year format. The supported options include YYYY (four-

digit year) and YY (two-digit year). 

Date format Set the date format. 

Time type The supported options include Local Time and Network Time. 

Week Display or hide the week. 

 : Display the week. 

 : Hide the week. 

Time Display or hide the time. 
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Area Parameter Configuration 

 : Display the time. 

 : Hide the time. 

24-hour Display the time with 24-hour format or not. 

 : Display the time with 24-hour forma 

 : Display the time with 12-hour forma 

Time Format Set the time format. 

Layout Display mode Set the display mode of the time OSD. 

 Single-Line: Display the date, day of the week and time in 

single-line. 

 Multi-Line: Display each item in single-line. 

Spacing Spacing: Set the spacing between the date, day of the week and 

time in Single Line display mode or set the spacing between 

rows in Multi-Line display mode. 

Text Font Settings Select the desired text font from the drop-down list. 

Library  Delete single/multiple fonts: Click Library. In the popup 

window, check the boxes next to the desired fonts, and then 

click Delete to delete the selected fonts. 

 Delete all fonts: Click Library. In the popup window, check the 

box next to Library, and then click Delete to delete all fonts. 

 Add fonts: Click Library. In the popup window, click New to 

add the fonts saved in the local computer to the font library. 

Font size : Set the font size. The value ranges from 8 to 512 px and it 

defaults to 100 px. 

Font style  : Make the text bold or not. 

 : Italicize the text or not. 

 : Underline the text or not. 

Character spacing : Set the spacing between characters. The value ranges from 

0 to 1000 px and it defaults to 0 px. 

Row spacing : Set the spacing between rows. This parameter is available 

when there are multiple rows. The value ranges from 0 to 1000 

px and it defaults to 0 px. 

Alignment method  : Align the text content with the left margin of the display 

area. 

 : Center the text content in the display area. 
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Area Parameter Configuration 

  

Text position and 

size 

Set the position and size of the OSD component. 

 X: Set the horizontal distance from the top left corner of the 

OSD component to that of the screen. 

 Y: Set the vertical distance from the top left corner of the OSD 

component to that of the screen. 

 W: Set the OSD component width. 

 H: Set the OSD component height. 

Common 

properties 

Text color Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust 

the opacity. The opacity ranges from 0% (totally transparent) to 

100% (nontransparent). 

Background color Toggle on/off Background Color to enable or disable the 

background color settings. 

Click the color block icon next to Select Color to open a window 

where you can select the desired color or customize your own 

color. Drag the slider or enter a value in the text box to adjust 

the opacity. The opacity ranges from 0% (totally transparent) to 

100% (nontransparent). 

Configure Image OSD 

Add Image OSDs 

Step 1 In the screen list on the left, select the desired screen. 

Step 2 Click the OSD tab. 

Step 3 Toggle the OSD switch to  to enable the OSD function. 
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Figure 3-46 Enable OSD 

 

Step 4 Click the Image OSD tab to enter the image OSD configuration page. 

Step 5 Click  to open a window where you can select the desired OSD images. 

Step 6 Click Open to upload the selected images. 

Step 7 Click and drag the uploaded image to the editing area to add an image OSD. 

Figure 3-47 Add image OSDs 

 

Step 8 Set the position and size of the OSD layer. 

 X: Set the horizontal distance from the top left corner of the OSD layer to that of the screen. 
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 Y: Set the vertical distance from the top left corner of the OSD layer to that of the screen. 

Delete Gallery Images 

 Delete a single image: Hover the mouse over the desired image, and then click . In the 

popup dialog box, select Yes to delete the selected image. 

 Delete multiple images: Click Edit, and then check the boxes next to the desired image or 

check the box next to All. After selection, click  and select Yes in the popup dialog box. 

Export Gallery Images 

Click Edit, and then click . In the popup window, select the saving path to export all images 

in the gallery to your local computer. 

Manage Presets 

To manage the presets, click Preset on the right side of the Programming interface and 

perform the corresponding actions as needed. 

Save Presets 

Step 1 In the screen list on the left, select the desired screen. 

Step 2 On the Preset tab interface, click Add at the bottom, and the system will automatically display 

the preset number binding window. 
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Figure 3-48 Bind presets (VX2000 Pro) 

 

Figure 3-49 Bind presets (VC6 Pro) 

 

Step 3 In the preset number binding window, select the desired key number to save the current layer 

information to the preset. 

One key number corresponds to one preset. The name of the save preset: Preset X ("X" refers to 

the bound key number.) 

Switch Display Style of Preset List 

 : List view 
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 : Graphical view 

 

Load Presets 

In the preset list, select the desired preset to load it. 

After the preset is successfully loaded, the  icon will be displayed at the top left of the 

preview area. 

Rename Presets 

 In the list view mode ( ), hover the mouse over the preset, and then click . Enter a new 

name and then click elsewhere to make the change take effect. 

 In the graphical view mode ( ), hover the mouse over the preview area, and then click  

that appears. In the popup menu, select Rename and enter a new name, and then click 

elsewhere to make the change take effect. 

View Preset Details 

 In the list view mode ( ), hover the mouse over the preset, and then click  that appears. 

In the popup window, you can view the name and screen of the preset. 

 In the graphical view mode ( ), hover the mouse over the preview area, and then click  

that appears. In the popup menu, select Details to show the popup window where you can 

view the name and screen of the preset. 
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Set Preset Switching Effect 

Click , and then select the desired transition effect in the popup menu. The supported 

options are as follows. 

 Cut: Switch one preset to another with no transition effect. 

 Fade: Switch one preset to another with a fade effect. 

After selecting Fade effect, click OK in the popup dialog box. Additionally, you can set the 

transition duration. The value ranges from 1s to 3s and it defaults to 2s. 

 

 The fade effect takes effect on presets with less than 7x SL layers only. 

 Only the VX2000 Pro supports setting of the preset switching effect. 
 

Delete Single Presets 

 In the list view mode ( ), hover the mouse over the preset, and then click  that appears. 

In the popup window, select Yes to delete the preset. 

 In the graphical view mode ( ), hover the mouse over the preview area, and then click  

that appears. In the popup menu, select Delete, and then select Yes in the popup dialog box. 

Delete Multiple Presets 

Click Operation, check the boxes next to the desired presets or check Select All, and click . 

In the pop-up dialog box, select Yes. 

Tools 

Maintenance 

Maintain Devices 

In the menu bar, navigate to Tools > Maintain. Select the Device tab and the target devices, 

and then do the following as required. 
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Figure 3-50 Device maintenance (VX2000 Pro) 

 

Figure 3-51 Device maintenance (VC6 Pro) 

 

Update 

 

 During the update process, power-off and all operations are NOT allowed. 

 Before updating the device, please connect the control PC and device using an Ethernet cable. 

USB connection is not allowed for update. 
 



 
Unico Control Platform User Manual 

 

 

www.novastar.tech 119 
 

Step 1 Click Update. 

Step 2 In the pop-up dialog box, select the update file (.img) and click OK. 

Step 3 Confirm the devices to be updated, and click the Update button. 

Step 4 In the pop-up dialog box, click Yes and wait until the update completes. 

Step 5 After the update completes, click OK. 

Restart 

Click Restart. In the displayed dialog box, click Yes to restart the device. 

Factory Reset 

 

 Please do this with great caution. 

 The reset action does not affect the device firmware version. 

 Power-off is NOT allowed during the reset process. 

 The device will restart automatically after the reset is completed. 
 

Click Factory Reset. In the pop-up dialog box, select Keep user data, Retain IP only or Reset 

all, and then click OK. 

 Retain user data 

Retain the input EDID, imported files, language, device name, device IP, belonged project 

and restore points. 

 Retain IP only 

Only retain the device IP address and reset other parameters to factory defaults. 

 Reset all 

Reset all parameters. 
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Figure 3-52 Factory reset 

 

Export Logs 

Click Export Log. In the dialog box that appears, select a path and click Save to save the device 

logs to local computer. 

Device Diagnostics 

Click Diagnostics. After the diagnostics completes, you can view the test result and take 

necessary measures as required. 

Figure 3-53 Device diagnostics (VX2000 Pro) 
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Figure 3-54 Device diagnostics (VC6 Pro) 

 

Maintain Cabinets 

In the menu bar, navigate to Tools > Maintain. Select the Cabinet tab and the target cabinets, 

and then do the following as required. 

Figure 3-55 Maintain cabinets 
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View Cabinet Information 

View the cabinet online status, cabinet manufacture, cabinet model, receiving card model, 

receiving card firmware, associated device, card (only applicable for card-based device), device 

IP and cabinet position. 

View Receiving Card Firmware 

Click Details to view the FPGA and MCU versions of the receiving card. 

Cabinet Painter 

Click Painter and select one or more cabinets so that other cabinets can have the same 

firmware program and configuration file as the selected cabinet. 

Update Cabinet Configuration Files 

Select one or multiple cabinets, and then click Update. 

Figure 3-56 Update cabinets 

 

Select the desired update method in the popup window. 

 Select an existing file: Choose an NCP/rcfgx file from the popup window and click Update. 

 Import a new file: Click Import to upload an NCP/ file. You can select the import objects 

(multiple selections are possible) from Local pack or Device pack. Once the upload is 

complete, return to the Update interface, select the imported NCP/rcfgx file, and click 

Update. 

 Firmware Program: Update the firmware version of the receiving card. Upload a file in image 

format, and then click Update. 

 Configuration File: Update the cabinet configuration file. Upload an NCP/ rcfgx file, and then 

click Update. 
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 Image Quality File: Import the adjustment parameters of the image quality. Upload a file in 

vglcx format, and then click Update. 

 

The supported cabinet update method depends on the receiving card model. 
 

Restart Cabinet 

Click Restart. In the popup dialog box, click OK to restart the cabinet. 

Refresh Cabinet Info 

Click Refresh to refresh the cabinet information. 

Configure Device Backup 

Device backup allows you to set the backup relationship between two devices. You can set one 

of the devices as the primary device or the backup device. When the primary device has a 

problem or the primary device's Ethernet cable fails, the backup device will take over the 

responsibilities of the primary device seamlessly and continue to work well to ensure the LED 

screen will not go black. 

Prerequisites 

 Before creating a backup relation, make sure that both the primary and backup devices are 

on the same LAN. 

 In a backup relation, the models and device versions of the primary and backup devices must 

be the same. 

Notes 

 You have three options to create a backup relation: NovaLCT, Unico, or the device LCD 

menu. However, be aware that these methods do not synchronize with each other. Using 

more than one can lead to data problems. To prevent issues, choose only one method for 

setting up your backup. If you do mix them, you'll need to reset the device to factory settings 

and start over with just one method. 
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 In the device backup mode, the quantity of the cabinets loaded by each Ethernet port on 

both the primary and backup devices must be the same, but their data flow must be in a 

reversed way. 

Operation Procedure 

Step 1 In the menu bar, go to Settings > Device Backup. 

Step 2 In the pop-up window, click Add to add a backup relation. 

Figure 3-57 Add backup relations (VX2000 Pro) 

 

Figure 3-58 Add backup relations (VC6 Pro) 

 

Step 3 Select the primary and backup devices from the drop-down lists respectively. 
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After the action completes, the firmware versions of the primary and backup devices will be 

displayed. 

Step 4 Click OK to complete the backup relation settings. 

Step 5 (Optional) Click Delete to delete the desired backup relation. 

Manage Cabinet Library 

In the menu bar, go to Tools > Cabinet Library. Do the followings as needed to manage the 

cabinet library files. 

 

Upload Cabinet Files 

Step 1 Click Add and select the cabinet type in the displayed window. 

The cabinet types are as follows. 

 Cabinet File 
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Figure 3-59 Cabinet files 

 

 Virtual Cabinet: If Virtual Cabinet is selected, you need to configure the parameters such as 

cabinet name, resolution width and height. 

Figure 3-60 Virtual cabinets 

 

Step 2 Select the NCP/.rcfgx file to be imported from the local computer and click Upload. 

After the file is selected, you can click Delete to delete the uploaded file. 

Export Cabinet Files 

Step 1 Select one or more files on the Cabinet Library interface and then click Export. 

For batch export, multiple files will be compressed as a .zip file and exported. 

Step 2 Select a local directory and click Save. 
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Sync Cabinet Files 

 Sync cabinet files between devices 

1) Select the files to be synced (multiple files can be selected), and click Sync Cabinet 

Library. 

2) On the displayed window, select the devices to which the files are synced (multiple 

devices can be selected). 

Figure 3-61 Sync cabinet files (VX2000 Pro) 

 

Figure 3-62 Sync cabinet files (VC6 Pro) 

 

3) Click OK. 

View Cabinet and Flash Info 

Select a cabinet file, and the information about all the cabinets that use this cabinet file will be 

displayed. 
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Device Discovery 

Add devices across different network segments or non-discoverable devices via IP addresses. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 

Prerequisites 

None 

Notes 

None 

Interface Example 

 

Configuration 

Navigate to Tools > Device Discovery from the menu bar. In the popup window, click Add to 

manually input the device IP. Once added, click OK. 

Test Tool 

Utilize test patterns to assess display performance and pinpoint issues. 

Applicable Products 

VC6 Pro, VC10 Pro, VC16 Pro, VX400 Pro, VX600 Pro, VX1000 Pro, VX2000 Pro 
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Prerequisites 

For better software operation when the display window is large, it is recommended to prepare 

an extended display for viewing test patterns. 

Notes 

The test tool only supports Windows operating systems. 

Interface Example 

 

Description 

Navigate to Tools > Test Tool from the menu bar to open the test tool configuration interface. 

Please refer to the Test Tools User Manual for specific operations. 

Software Settings 

Switch UI Language 

Select the desired language from the drop-down list at the top right corner to switch the UI 

language. 
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Change Skin 

In the upper right corner of the interface, click  to select the desired skin. 

Figure 3-63 Change skin 

 

Export Logs 

In the menu bar, navigate to Settings > Export Log to export the logs of the Unico software. 

Configure Preferences 

In the menu bar, navigate to Settings > Preferences. Turn on the desired features (checked "√") 

or off (unchecked). 

 Screen Resources: Show the layer resources on the Programming interface if enabled. 

 Lock Aspect Ratio: Lock the aspect ratio when adjusting the width and height of new layers 

if enabled. 

View Software Info 

In the menu bar, go to Help > About Us to view the software-related info. 

Check User Manual 

In the menu bar, navigate to Help > User Manual to scan the QR code or click the link provided 

to access the latest product documentation. 
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 Appendix 

Loading Capacity Calculation Method in Low Latency 

Mode 

In low latency mode, the effective loading capacity of a single Ethernet port will change 

according to the coordinates of the connected cabinets. This chapter introduces how to 

calculate the effective loading capacity of an Ethernet port in low latency mode. 

Calculation Formula 

Max loading capacity of a single Ethernet port = (1 - (Y / H)) × TOTAL 

 Y: The minimum Y coordinate of all cabinets loaded by a single Ethernet port 

 H: The total height of the current canvas 

 TOTAL: The maximum loading capacity of a single Ethernet port in common mode, fixed to 

650,000. 

Calculation Example 

As shown in the figure below, the minimum Y coordinate of the cabinets connected to an 

Ethernet port is 1200 (Y = 1200), the total height of the canvas is 2160 (H = 2160), and the max 

loading capacity is 650,000 (TOTAL = 650,000). Based on the calculation formula, the maximum 

loading capacity of this Ethernet port in low latency mode is: 

(1 - (1200 / 2160)) × 650,000 ≈ 0.556 × 650,000 ≈ 361,400 
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The loading capacity of the Ethernet port is only related to the minimum Y coordinate of the 

connected cabinets and has nothing to do with the X coordinate. 
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